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1 Quick Start Guide

1.1 Overview
This chapter is a quick guide to the TDA5150 evaluation environment installation and usage, showing how to

• install the TESEUS software tool
• connect the Hardware and set up the TDA5150 evaluation environment
• start your first radio transmissions

Note: In order to work with the TDA5150 Evaluation Kit, at least one Evaluation Board and one SIB board 
(Version V1.2) are required. For order codes see Table 5

Attention: The SIB board V1.2, which is part of the TDA5150 Evaluation Kit contains a dedicated Firmware, 
suitable for operation with TDA5150 chips. 
No other SIB boards (for instance V2, part of TDA5240 Receiver Kit) may be used

The final part of this booklet contains hints and recommendations regarding the implementation of SPI bus
communication in a stand-alone system (i.e the TDA5150 transmitter is under the control of a host system, usually
a microcontroller).

It is recommended, that users of the TDA5150 transmitter read through those details after getting familiarized with
the TESEUS environment, but before switching to implementation of their own, stand-alone applications, to
shorten the learning curve. 

1.2 Software installation and Hardware setup
In order to install the TESEUS tool, first time users have to go through following steps

• Do not plug in the SIB board into a USB slot of the PC, before the TESEUS tool and the drivers associated to 
the SIB board are installed, otherwise a Missing Driver error message may occur

• Start the installation of TESEUS and above mentioned drivers, by clicking on the icon of self-extracting 
TESEUS.exe package (icon is shown below)

Figure 1 Icon of the self-extracting package

• Choose the directory location and the installation mode - shared or individual (example for individual install is 
shown below) and follow the instructions. Before proceeding with the installation, please read carefully the 
software disclaimer and EULA agreement (and click on Accept to proceed with install).
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Figure 2 Select the directory location for install

At the end of installation process, a TESEUS shortcut will appear on the desktop, as shown below

Figure 3 TESEUS icon after install

Now, having the TESEUS installation closed, plug the TDA5150 Evaluation Board and the SIB (Standard
Interface Board) together, as shown below. Connect the SIB board to a free USB port of a PC with a USB cable
(delivered with TDA5150 Evaluation Kit or a similar one). It is recommended to use a USB cable not longer then
1 meter (3 feet 4 inch).

Figure 4 Evaluation Board plugged into SIB board, top side view
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If the SIB board is connected for first time to a USB port of a certain PC, a Found New Hardware message pops
up - as shown below and the drivers for the SIB Board are installed automatically. Please wait until the installation
is completed, and the Found New Hardware message window deleted from desktop.

Figure 5 Found New Hardware message

After the installation is properly finished, you can proceed with the next step. 
Restart of the PC after TESEUS and driver installations have been finished is not mandatory.

1.3  Hardware setup and functional check
The TDA5150 Evaluation Board can be supplied either from an external power source (voltage range from
minimum 1.9 V up to maximum 3.6 V) or use the regulated voltage delivered by SIB board. 

The later one is user programmable in the 1,9..3,6V range (see also SIB Parameters window in General tab of
TESEUS GUI Figure 24). 

Attention: Supply voltages exceeding 3,6V (the operating range maximum rating for TDA5150) may cause 
permanent damage to the device.

Jumper JP1 does select the power supply origin for the Evaluation Board (internal or external). For internal
supply jumper JP1 is set as shown below. For supply voltage distribution scheme see also Figure 31. 
Notice that the SIB board itself is always supplied via the USB power line, the external supply option applies only
for the Evaluation Board.

Figure 6 Configuration Supply Voltage source

In order to execute a functional check, start TESEUS (from Start Menu or left-click the icon) and choose the
desired operation mode (Basic Mode, Advanced Mode or Firmware Mode). Chapter 3.2.1describes in detail
the Operation Modes.

TDA5150 Interface Board V1.2
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Figure 7 TESEUS Operation Modes

For a brief functional check, click on Read Status Registers button after TESEUS started and check if TDA5150
detected and SIB Board connected LEDs in the lower bar area are lit up in green (each mouseclick on the button
does update the connection status). 

If the green LEDs are not lit, there is no communication between transmitter board, SIB and/or the PC. For re-
establishing the communication, check if the USB cable and the connectors on SIB and transmitter board are
properly plugged in, and if the jumper JP1 is set for external supply option, check the state of the power supply
(must be ON), then read the status again by clicking on the Read Status Registers button.

Figure 8 Status and error indicators in TESEUS GUI

1.4 Working with TESEUS
After getting TESEUS started, click on Update Registers followed by Read Status Registers button. 

If the system is functional,i.e. SIB-to-PC and SIB-to-Evaluation Board connections are established, then the two
green LEDs should light. If this does not happen, it is usually an indication either of connection problem (SIB-to-
PC and/or SIB-to-Evaluation Board) or of missing supply voltage. 

Further if the connection status is ok (indicated by green LEDs) but one or more status indicator LEDs are lighting
in red (i.e PLL Lock Error, Parity Error, Brownout Error, VCO Autocalibration Failure) the device’s RF power
amplifier will be turned off and transmission stopped (as long as the FailSafe is armed and active) thus avoiding
erroneous transmissions. Please refer to the TDA5150 Datasheet for detailed explanation and root cause finding
(see FailSafe mechanism, Chapter 1.5.6 in TDA5150 Datasheet V1.0, release July 2009).

In next step load the preferred TESEUS settings by selecting the Load settings command from the File menu or
set the wanted values in accordance with description of the TDA5150 registers (details described in Datasheet).
The newly defined or modified settings may be saved by choosing Save Settings from the File menu.

Figure 9 Recall previously stored settings

Attention: Make sure that the nominal crystal frequency in TESEUS corresponds to the crystal frequency on your 
TDA5150 board. A difference between the crystal frequency (in HW) and the nominal value, entered 
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in TESEUS will lead to a frequency error (deviation from nominal / wanted frequency). Enter the correct 
crystal frequency value in the corresponding TESEUS Function Tab (General/XOSC/Encoding/SIB)

In the next step choose Device Evaluation or System Emulation mode in Transmission tab. If Device
Evaluation mode is selected, set the parameters associated with TX Command Byte (see also screenshot below).
For more information on the TX Command Byte structure, refer to TDA5150 Datasheet.

Figure 10 Transmission tab

Attention: Only if System Emulation (i.e. Datagram Mode) is selected the TX Command Byte settings are taken 
over from the TX file. The parameters listed in the file are automatically displayed by TESEUS as long 
as TX Command dialog box is active.

If Advanced Mode or Firmware Mode is used, select from File menu Save Sample Tx File to save the used file
(usually into a project folder). The TX file(s) may be modified and/or renamed - if necessary and later the settings
retrieved by loading them again. This might save time during development work and will minimize the potential of
error occurrence due to inconsistencies in file content(s). The selected TX_file long path appears in the dialog box.
Transmission in Basic Mode uses a default (predefined) datagram. Refer to Chapter 3.3.2 for details.

The screenshot below is an example for Sample Tx File.
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Figure 11 Sample Tx File

Now as all the parameters required by transmission have been updated, it’s time to check if the prerequirements
for starting an RF-transmission are fulfilled and transmit the Datagram.

To check if there occurred any error conditions since the last transmission (or since last Reset) click on the Update
Registers button, and then on Read Status Registers. 
This action clears also the latched error flags, details are explained below.

If one or more of the status indicator LEDs are lit red (i.e PLL Lock Error, Parity Error, Brownout Error, VCO
Autocalibration Failure) then the device’s RF power amplifier will be turned off and transmission stopped (as long
as the FailSafe is armed and active) thus avoiding erroneous transmissions. Please refer to the TDA5150
Datasheet for a detailed explanation and root cause finding (see FailSafe mechanism; Chapter 1.5.6 in TDA5150
Datasheet V1.0, release July 2009).

Further keep in mind that reading the Status Registers delivers the previously latched error(s) and - at the same
time clears the Error Flags in Status Register. 

The example below shows a Brownout Error. It might happen, that the brownout condition has already vanished
(i.e. just a short voltage drop below the brownout threshold detected from Brownout Detector block), but the error
is still latched until it is cleared by reading the Status Register or by a Reset.

Figure 12 Brownout Error condition

Having checked for errors it’s time to start a transmission. To do so, press the Transmit button associated to a
channel (A..D) in the Transmit tab. 
Up to four different Datagrams can be loaded and sent individually, as shown below. The number of repetitions
for Datagram transmission and the corresponding PLL Channel can be set as well.
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Notice that in the recent TESEUS implementation (V3.2.11) all datagrams are associated to one and the same
PLL Channel (A, B, C or D). In the next editions each Datagram should be associated to an individual PLL
Channel, independently from the others (i.e for instance Datagram1 to Channel A; Datagram2 to Channel C;
Datagram3 to Channel B and so on, without restrictions regarding the sequence of associations).

Figure 13 Transmit a Sample Tx File in Device Emulation mode
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2 Introduction

2.1 Software Overview
At Infineon Technologies we believe that the supporting process is a key factor for your success. This software
tool is intended to help you to shorten the design cycle by embedding of TDA5150 into a host system.

TESEUS is supporting the evaluation of multi-band, multi-channel transmitter of Infineon, the TDA5150 chip.

The term “device evaluation” means that the customer will be able by using the included SW and the Evaluation
Kit to fully evaluate the performance of the transmitter device itself (in conjunction with an Infineon Evaluation
Board). This ability is referred as Device Evaluation mode.

The software is also capable of emulating the behavior of a generic microcontroller which is usually part of a
generic application. That is, the SW embeds the ability of transmitting data via the TDA5150 and one or more RF
Channels to a not specified receiver, the same way as things would work in a generic application. This ability is
referred as System Emulation capability.

TESEUS is used to configure the TDA5150 transmitter and to generate the appropriate register settings. The tool
does offer a set of dialogs to configure the TDA5150. Each functional unit of the TDA5150 which is visible to user
(and is described in the associated Datasheet) is controlled by a separate dialog box. By using the tool a user is
able to execute transmissions, save and retrieve project settings including but not limited to SFR register settings
and transmission datafiles as well.

2.2 Evaluation Kit Components
TESEUS is part of the TDA5150 evaluation environment. In order to perform your evaluation task, will you need:

• a TDA5150 SIB Board (version V1.2, acting as controller towards the TDA5150 transmitter)
• a USB cable for the interconnection between the SIB Board and the PC
• a TDA5150 Evaluation Board, assembled in accordance with the parameters listed in Table 5 (frequency band 

and RF output power classes). This Evaluation Board can be plugged into the connector of a SIB board, but if 
the customer does wish so, it can be controlled by an external uC, via the SPI bus. In this case the proper 
supply voltage of 1,9..3,6V must be provided by an external power supply or from the uC-board (as the SIB-
board is NOT plugged in, there is no supply voltage available from SIB-board in this case)

• a personal computer with at least one free USB port and one of the following operating systems (OS) installed: 
Windows 2000; Windows XP (32 bit or 64 bit); Windows Vista (32 or 64 bit); Windows 7 (32 or 64 bit)

2.3 TDA5150 Overview
The TDA5150 is a low power ASK/FSK RF transmitter for the ISM frequency bands 300-320MHz, 425-450 MHz,
863-870 MHz and 902-928 MHz.

Bi-phase modulation schemes like Manchester, bi-phase mark, bi-phase space, etc. are supported. The IC offers
a high level of integration and needs only a few external components, like a crystal, a few blocking capacitors and
the necessary matching elements on the RF-PA output. A fully integrated sigma-delta fractional-N PLL synthesizer
covers all above mentioned frequency bands with a high frequency resolution, using only one VCO running around
1.8 GHz. The on-chip synthesizer comprises a VCO, several dividers, loop filter with programmable bandwidth
and a highly accurate 3rd order sigma-delta modulator.

With a programmable data shaping filter, a very accurate GFSK modulation is achieved.

The output stage of the TDA5150 contains a C class power amplifier with a very good efficiency factor, several
selectable power stages and user-selectable RF output power level.

A shaped ASK-data input is also provided.

On chip antenna matching capacitor array is available (for tuning).

The main clock source is a single-pin crystal oscillator running at around 13.00 MHz. Datasheet specified
frequency range of this reference clock is 12MHz..14MHz.
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A programmable divided clock output is available. The device is configured by means of a 3-wire interface (SPI
bus), programmable even during power down state.

2.4 TDA5150 Features
The main features of the TDA 5150 transmitter are

• Sigma-delta fractional-N PLL synthesizer with high frequency resolution (<7 Hz)
• Multiband / Multichannel operation (300-320 MHz, 425-450 MHz, 863-870 MHz, 902-928 MHz)
• Supply voltage range 1.9V - 3.6V
• Low battery detector with two threshold levels (2.1 V and 2.4 V)
• Small package size (TSSOP-10)
• Operating temperature range -40°C to +85°C
• Full qualification for automotive standard
• Modulation types ASK (OOK), FSK (CPFSK) and GFSK
• Supports all bi-phase encoding formats
• Low supply current (Power down less then 0.5 mA, RF transmission 9mA @ +5 dBm)
• Programable output power, with nominal levels of +5 dBm, +8 dBm, +10 dBm
• Software selectable on-chip tuning capacitors for antenna matching network
• Programmable divided clock output (for clocking external devices)
• Integrated 3-wire serial interface bus (SPI)

2.5 Applications
• Remote keyless entry systems
• Short range radio data transmission
• Remote control units
• Tire pressure monitoring
• Remote metering and telemetry applications
• Cordless alarm systems



TDA5150
TDA5150 Evaluation Kit

Description  

 User Guide 17 Rev. 1.0, 2010-01-15
 

3 Description

3.1 Installation

3.1.1 Hardware and Software Requirements
In order to work with TESEUS, the following hardware and software components are required

• PC with (at least) one of Microsoft’s following OS installed: 
Windows 2000; Windows XP (32 bit or 64 bit); Windows Vista (32 or 64 bit) or Windows 7 (32 or 64 bit)

• One free USB port (for PC to SIB board connection)
• Recommended graphical screen resolution – 1024 by 768 pixels, or larger
• FTDI driver package for your installed Windows operating system. 

These drivers, required by SIB board (V1.2) are part of the TESEUS distribution package and are installed 
automatically during the installation of TESEUS tool

Note: Additionally Microsoft .Net Framework Version 2.0 (or newer version) is required. This is usually part of the 
Windows installation packages. If there is no .NET Framework version 2.0 installed on the used PC, you’ll 
be prompted to install it. The TESEUS package contains a redistributable version of .NET 2.0. 
Either use this package or download the recent .NET Framework Version Redistributable Package from 
Microsoft’s web page http://www.microsoft.com/downloads/en/default.aspx
Please be aware of the minimum requirements and resources for installing the .NET Version 2.0 or never 
(list on Microsoft web-page)

Attention: Please install TESEUS before plugging in the first time the SIB board to your USB port 
(otherwise, after the Found New Hardware prompt you should be asked to localize the driver source 
files)

3.1.2 Installation of TESEUS
To install TESEUS follow the sequence described below

• Copy the distributed TESEUS.exe self-extracting file to a hard disk drive (usually the C: drive). You can 
eventually download it from the www.infineon.com/wirelesscontrol site

• Click on the self-extracting TESEUS.exe file (delivered by Infineon or the recently downloaded one)
• The installation will start and execute automatically 
• During installation a default folder will be created under

– C:\Program Files\Infineon Technologies\TESEUS
– if the user does not modify the path, as explained, based on an example by Figure 2

Attention: due to security features, TESEUS does not run if launched from a remote (network) drive. Please make 
sure that TESEUS directory is located on a physical (local) drive on your PC and that you have the 
required user rights to execute it

Note: TESEUS requires Microsoft .NET Framework Version 2.0. If .NET Version 2.0 is not available in your MS 
Operating System, a message box will ask for download /install the .Net Framework Version 2.0. In this case, 
install the .NET 2. 0 Redistributable package delivered with TESEUS installation package or download a 
newer version, directly from Microsoft.

• Having TESEUS installed, simply plug in the SIB board into a free USB port of the PC via the USB cable 
provided with the Evaluation Kit. The SIB board drivers are automatically installed during the installation of 
TESEUS. The Plug and Play feature of the SIB board will create two channels, designated as Channel A and 
Channel B within the established USB connection

• You are now ready for launching and running TESEUS by simply double-clicking the TESEUS shortcut icon 
on your desktop (or in START menu)
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Note:  Checking if the USB drivers are correctly installed and the connection is working can be done opening the 
Universal Serial Bus controllers field in the Device Manager folder. Different operating systems (Win7, 
Vista, XP, W2K) offer slightly different path to Device Manager, but the principle is the same for all. To open 
the Device Manager folder, for instance under W2K, click Start, point to Settings, click Control Panel, and 
then double-click System. Click the Hardware tab, and then click Device Manager. Under the Universal 
Serial Bus controllers root, you should find the list of installed drivers. The drivers required by SIB board 
are named FT2232C Channel A and FT2232C Channel B. Independently of the installed OS, in doubt or if 
there is a systematic connection error between the PC and the SIB board (i.e. the error LEDs in TESEUS’s 
Status Bar are lighting) please make shure the USB channel (s) are not marked as in error (this happens 
usually due to missing driver)

Figure 14 USB ports in Device Manager, as listed in Windows 7

3.2  User Interfaces and Getting started actions
The TDA5150 Evaluation Board can be supplied either from an external power source (voltage range from
minimum 1.9 V up to maximum 3.6 V) or use the regulated voltage delivered by SIB board. 

3.2.1 GUI Description: Basic, Advanced and Firmware Mode configurations
TESEUS starts in a window which allows the user to choose from three possible Configuration GUIs

Figure 15 TESEUS startup GUI

These different GUIs visualize a choice of control tabs and settings, tailored to the user’s needs. Namely these are:

• Basic Configuration: in this mode the user is asked to program just a minimum number of parameters. This 
configuration is recommended for getting started with the device or for simple functional tests.
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• Advanced Configuration: the user is offered a wider choice of programable device registers (SFRs). Anyway 
TESEUS takes over the programming of some parameters in order to assist the user by setting the correct 
values and at the same time to reduce the probability of an erroneous configuration occurrence. This GUI is 
recommended for in-depth evaluation of the device.

• Firmware Configuration: within this GUI, the user is given access to all the parameters and SFRs, without 
any limitation imposed by the software. By providing a high degree of freedom, this GUI is recommended for 
users already familiarized with the device.

After one of the three Configuration GUIs is selected, a new window opens, containing additional Tabs, like
shown below..

Figure 16 Basic Configuration GUI window

Note: By un-checking the Show Startup Selection Dialog in the Help menu, the Configuration GUI window is disabled and 

TESEUS will start the next session with the last used GUI.

Figure 17 Switching between Configuration Modes

Each Configuration Mode allows the user to

• configure the registers 
(the number and function of user-accessible SFRs depends from the used Configuration Mode)

• configure the transmission mode (ASK; FSK; GFSK), RF-power and to transmit data but the degree of 
configuration flexibility and access to in-depth parameters is different
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3.2.2 Configure the SFR registers
TESEUS assists the user by configuring the registers of the TDA5150 in an easy and comprehensive way. Each
register is described by its tooltip descriptor which is visualized by passing the pointer of your mouse on the
command. Please refer to the TDA5150 Datasheet for detailed explanation of the register functions and for the
TDA5150 behavior. The mentioned registers are referenced as SFRs (Special Function Registers) in the
TDA5150 Datasheet and Application Notes.

By pressing <F1> when the pointer is hovering over special dialog boxes, an Explanation Note describing the
particular function will pop up.

3.2.3 Transmission Modes
Using TESEUS can significantly shorten the design cycles by supporting the designer both in the evaluation
process and the application development. This is achieved by the ability of transmitting both a continuous data
stream for Device Evaluation purposes, or a signal modulated with a customer-specific datagram, as a normal
application would do. This ability is referred within this document as System Emulation capability.

In this way, the Infineon TDA5150 Evaluation Kit comes closer to your final application.

Device Evaluation and System Emulation are options in the Transmission tabs of Basic Configuration,
Advanced Configuration and Firmware Configuration modes. 

During programming the registers of the TDA5150 transmitter, via one of the three configuration modes (Basic;
Advanced or Firmware), please check out the Transmission tab corresponding to the desired transmission mode
(Device Evaluation or System Emulation)

Note: in Basic Mode the appearance of the Transmission tab is slightly different from those in Advanced Mode 
and Firmware Mode, as these offer a larger number of parameter choices and Data Frame 
configuration, some of these features are blanked out in Basic Mode

Figure 18 Device Evaluation and System Emulation options, as they appear in Basic Mode

3.2.3.1 Device Evaluation Mode
After selecting the Device Evaluation Mode, a new transmission can be started by clicking the TX Start button.
A continuous RF transmission is then generated according to the parameters downloaded into the SFRs of the
TDATDA5150. The modulated information is the datagram contained within Transmission File which has been
selected in advance, iterated by an infinite loop. The transmission is interrupted (stopped) by clicking the TX Stop
button or if editing any parameter in TESEUS is started. Thus inconsistencies (transmission of partially edited files)
is avoided by forcing TX Stop during editing operations.
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The effect of Device Emulation mode is the same for Basic, Advanced and Firmware configuration GUIs.
Contrary to Firmware and Advanced mode, in Basic mode a predefined datagram is used, and it is not possible
to select a user-defined one.

3.2.3.2 System Emulation Mode 
The System Evaluation mode allows you to program the device to transmit a datagram (i.e. a string of data) once
or several times (by a programable number of repetitions). According to the Basic Configuration vs. Advanced
and Firmware configuration environments, a default message is sent instead of a fully definable one. The aim is
to emulate via software the behavior of the TDA5150, as it would operate under the control of a generic
microcontroller or an equivalent host.

The datagram is transmitted after clicking the TX Start button and ends when the datagram is completely
transmitted or when the transmission is intentionally aborted by clicking the TX Stop button, whichever happens
first.

3.2.4 File menu
The File menu in the TESEUS tool-bar gives access for the user to save, load and export functions, thus the
settings used to program the TDA5150 can be saved and retrieved.

After configuring all the required registers and dialog boxes, a register configuration file is generated and saved
by clicking Save Settings in the File menu of TESEUS tool-bar.

Figure 19 File menu

Teseus uses its own file settings format, with the generic extension .nxs. A control window for selecting the path
and file name will be prompted to the user. At the same time a default path and file name are suggested by the
system. The user can overwrite the existing file or rename it, in case the file already exists. Afterwards the .nxs file
can be loaded at your convenience by choosing Load Settings and browsing to the folder containing the wanted
file. 

Teseus may be used to export a readable settings file. These list of settings, converted into a Register value file
might be used as source during the programming process of a microcontroller (or host), interfaced with the
TDA5150 and controlling it.

Table 2 File menu description

Command Description Hot Key Note

Load Settings Loads .nxs Teseus settings file Ctrl+L

Save Settings Generates and saves .nxs Teseus settings file Ctrl+S

Presets Load default .nxs settings file

Export Register File Export Registers values in a .txt text file (ASCII) Ctrl+R not available in 
Basic Mode
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3.2.5 Edit menu
The Edit menu contains the classic functions Cut, Copy, Paste and Delete.

3.2.6 Mode menu
The Mode menu allows the swap between Basic, Advanced and Firmware configuration GUIs. For further
explanation, please refer to Chapter 3.2.1

3.2.7 HELP menu
The Help menu gives access to all those implemented options and functionality which make the approach to the
software easy and its usage comfortable. 

If the Show Tooltips option is activated (under the Help menu) then, whenever the pointer of the mouse is
hovering over a programmable field, a callout will appear, delivering information about the pointed register like: 

• register description
• functionality
• SFR address (in hexadecimal format)
• selectable values
• tips

The Help menu can be activated by pressing <F1> as well as in the specific Explication Notes related to the
popped-up topic. This option, together with a very intuitive layout keeps you on the good track and avoids the “feel
lost” impression during navigation between settings and dialog boxes in TESEUS.

Figure 20 Help menu and tooltip activation

By checking the Show Startup Selection Dialog, the dialog box with choice of GUI modes will appear. By
disabling the dialog box, the last configuration mode will be loaded by the next launch of TESEUS. For further
explanation, please refer to “GUI Description: Basic, Advanced and Firmware Mode configurations” on
Page 18

Export C Header File Export Registers values in a .h C Language 
Header file

Ctrl+H not available in 
Basic Mode

Export C Source File Export Registers values in a .c C Language 
Source file

Ctrl+G not available in 
Basic Mode

Save Sample TX File Save the Template TX File used for Datagram 
Transmission

Quit Ctrl+Q

Table 2 File menu description

Command Description Hot Key Note
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Table 3 Help menu description

Command Description Hot Key Note

Show Tooltips Enables the tooltip feature. The pointer becomes 
a question mark (?)

Ctrl+T

Show Startup 
Selection Dialog

Enables the Configuration GUI window when 
starting the program. IF disabled, TESEUS will 
start the session with the last GUI used.

About TESEUS Returns the actual software version number and 
ownership information

Ctrl+I
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3.3 Basic Mode - getting started

3.3.1 Basic Mode configuration
The Basic Mode GUI allows the programming of the device with a basic set of parameters. In this way the user
can get accustomed with TESEUS and the TDA5150 architecture in a soft way, speeding-up the learning curve
on the device. In this mode a significant part of the registers (SFRs) are blocked from editing as they are
automatically programmed with default values. 
Anyway some of the important SFRs content is displayed -despite disabled editing, in order to make more
comprehensive the behavior of the device in Basic Mode. To use this mode, just start TESEUS and select Basic
Mode from the Startup Selection Dialog window.

Figure 21 Basic Mode configuration

In the Basic Configuration tab, the editable parameters are grouped as:

• XTAL Settings: this field contains the crystal frequency value, expressed in MHz. This must be in accordance 
with the crystal frequency on the used hardware (board). The TDA5150 EvalBoard provided by Infineon 
contains a crystal with nominal 13.00 MHz value. Anyway it is recommended to check the reference oscillator 
frequency and make fine adjustments (usually in magnitude below 1 kHz) if the unmodulated carrier (CW) 
frequency is offset from nominal RF channel value. This alignments can be done at best in ASK mode, as there 
is an equivocal carrier frequency, but also FSK (or GFSK) modulation may be used, with a symmetrical pattern 
(for instance 1010...10...) and then center the amplitude dip (i.e. the dip between the two FSK peaks, left and 
right from carrier on the frequency axis) on the nominal RF channel frequency by means of fine adjustments 
on the XTAL Freq value in the corresponding TESEUS tab. The alignments operation assumes access to a 
calibrated Frequency Counter or a Spectrum Analyzer, but with a slight trade off a frequency calibrated 
receiver may be used as well - then tune for best bit- or message error rate, by low RF signal levels. This 
assumes again an RF attenuator or a receiver placed almost to link range limit (far away from transmitter).

• Carrier Frequency: this field contains the RF frequency field value of the channel used. The ISM band field is 
automatically updated accordingly. It is recommended to select one or more channels within the ISM band for 
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which your Evaluation Board is matched, otherwise a significant drop of the RF power might occur (as the RF-
PA output would be severely mismatched). The ISM frequency band and nominal RF output power for which 
the board has been optimized are contained on a small sticker on the top side of the delivered Evaluation 
Boards.

• Output Power Settings: the RF output power of the device may be controlled by this parameter. Select the 
desired output power according to your Evaluation Board matching. To achieve the best PA efficiency and 
consequently low current consumption, make sure to configure the RF PA array for: 
– 9 stages if + 5 dBm output power is required
– 10 stages if +8 dBm output power is required
– 11 stages if +10 dBm output power is required

Note: The output power is determined not only by the number of active PA stages of the TDA5150 but it is also 
influenced by the load impedance of the RF power amplifier. Thus it is recommended to set the PA 
parameters (number of active stages) in accordance with the impedance (and nominal power) of the 
evaluation board under test to yield a minima of current consumption and maxima of efficiency.

• Modulation Settings: the possible modulation schemes are ASK and FSK. If FSK is chosen, the Frequency 
Deviation value have to be programmed as well (otherwise, with a default value of 0 Hz there should be no 
distinguishable RF carrier modulation)

3.3.2 Transmission in Basic Mode
In the Transmission Tab of the Basic Configuration, both the Device Evaluation and System Emulation can
be selected. With this GUI, the System Emulation Mode datagram is fixed and can not be redefined by user.

Figure 22 Transmission controls in Basic Mode

The default datagram is defined as following:

• Encoding: Manchester
• RunIn: 11 Bits of '0'
• TSID:  1 Bit of '1' 
• PayLoad: PRBS5 (31 Bit)
• EoM: 1 Bit 'M' , Manchester violation
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Figure 23 Default datagram structure, Basic Mode

The TX Command Byte is set by default according to the following description:

• Syncro with Bitrate disabled
• RF-PA off (disabled)
• Data Encoding disabled
• Transmission Setting 1
• Transmission Channel A
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3.4 Advanced User Interfaces
This GUI allows you to program all the registers of the TDA5150. The user will be guided through the device´s
setting. The registers are grouped in tabs according to functional building blocks and functions. Invalid data will be
recognized by automatic controls and proof within the dialog boxes (for instance not allowed transmit frequencies)

Figure 24 Advanced Mode: configuration tabs

For detailed description of registers and settings, please refer to the TDA5150 Datasheet and particularly to the
SFR descriptions. The TESEUS Tooltips embeds and synthesizes this information within the software (refer to the
Help menu).

Note: the majority of the registers have a suggested (default) value. These values are set according to typical 
implementations and environmental usage, but may be edited and changed.

3.4.1 Advanced Configuration
One of the first inputs required to run the system is the nominal frequency of the crystal oscillator.

Remember that the TDA5150 Evaluation Board provided by Infineon Technologies contains a crystal resonating
nominally at 13,00 MHz. It is possible to check the nominal frequency by reading the value on the case of the
crystal (values are given usually in kHz by most of manufacturers, i.e. 13.000 is the reading of the crystals mounted
on the Evaluation Boards).

Hint: Please follow these instructions, for easy measurement of actual crystal frequency

• Enter the nominal crystal frequency into the XTAL Settings field
• Program the device with the wanted nominal center frequency (fc)
• Keep in mind that the nominal carrier frequency (fc) is

 where r is the fractional divider value programmed in the TDA5150 (Divider window, as shown in Figure 25)

fc r fosc×=
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Figure 25 Channel frequency configuration in Advanced Mode

• Start a transmission in continuous mode (CW), choose FSK modulation with 0 Hz frequency deviation, and 
measure the actual carrier frequency with a spectrum analyzer or frequency counter. Using the value r it turns 
out that the actual crystal oscillator frequency is

• Enter the new XTAL settings value in the corresponding Teseus box and check again if the fc carrier is centred 
exactly (or at least within the desired frequency accuracy window) relative to the nominal channel frequency.

In order to easily program the TDA5150, it is recommended to enable the Tooltip option. Refer to “HELP menu”
on Page 22 for details.

Move the cursor and by pressing <F1> when the cursor is hovering over some specific fields, a related document
will pop up. This explains in details the way the device or the particular function works, and delivers useful hints.

3.4.2 Minimum set of registers which have to be programmed
In order to start a transmission a minimum set of SFRs of the TDA5150 must be programmed in advance, before
a transmission could be started. This is a mandatory action.

Below is a table listing the registers of the TDA5150

• in green are listed the registers mandatory to be programmed before a transmission can be started
• registers marked with black are the registers which should be used to ’customize’ the transmission (but can 

be left in default- i.e. after_Reset state as well). 
For default values please consult the TDA5150 Datasheet.

fosc fc r÷=
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Table 4 Special Function Registers (SFR) table

Register Addr Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

SPICHKSUM 0x00 SPICHKSUM SPICHKSUM SPICHKSUM SPICHKSUM SPICHKSUM SPICHKSUM SPICHKSUM SPICHKSUM

TXSTAT 0x01 1 n.u. LBD_2V1 LBD_2V4 VAC_FAIL BROUTERR PARERR PLLLDERR

VACRES 0x02 n.u. n.u. n.u. n.u. VAC_RES VAC_RES VAC_RES VAC_RES

VACDIFF 0x03 VAC_DIFF VAC_DIFF VAC_DIFF VAC_DIFF VAC_DIFF VAC_DIFF VAC_DIFF VAC_DIFF

TXCFG0 0x04 GO2STDBY reserved reserved FSOFF ISMB ISMB reserved PD_XOSC

TXCFG1 0x05 GO2SLEEP ASKFSK2 ASKFSK1 ASKSLOPE INVERT ENCMODE ENCMODE ENCMODE

CLKOUTCFG 0x06 CLKSRC CLKSRC AFTERSCALE AFTERSCALE PRESCALE PRESCALE PRESCALE CLKOUTENA

BDRDIV 0x07 BDRDIV BDRDIV BDRDIV BDRDIV BDRDIV BDRDIV BDRDIV BDRDIV

PRBS 0x08 PRBS PRBS PRBS PRBS PRBS PRBS PRBS PRBS

PLLINTA 0x09 n.u. PLLINTA PLLINTA PLLINTA PLLINTA PLLINTA PLLINTA PLLINTA

PLLFRACA0 0x0A PLLFRACA0 PLLFRACA0 PLLFRACA0 PLLFRACA0 PLLFRACA0 PLLFRACA0 PLLFRACA0 PLLFRACA0

PLLFRACA1 0x0B PLLFRACA1 PLLFRACA1 PLLFRACA1 PLLFRACA1 PLLFRACA1 PLLFRACA1 PLLFRACA1 PLLFRACA1

PLLFRACA2 0x0C n.u. n.u. FRACCOMPA PLLFRACA2 PLLFRACA2 PLLFRACA2 PLLFRACA2 PLLFRACA2

PLLINTB 0x0D n.u. PLLINTB PLLINTB PLLINTB PLLINTB PLLINTB PLLINTB PLLINTB

PLLFRACB0 0x0E PLLFRACB0 PLLFRACB0 PLLFRACB0 PLLFRACB0 PLLFRACB0 PLLFRACB0 PLLFRACB0 PLLFRACB0

PLLFRACB1 0x0F PLLFRACB1 PLLFRACB1 PLLFRACB1 PLLFRACB1 PLLFRACB1 PLLFRACB1 PLLFRACB1 PLLFRACB1

PLLFRACB2 0x10 n.u. n.u. FRACCOMPB PLLFRACB2 PLLFRACB2 PLLFRACB2 PLLFRACB2 PLLFRACB2

PLLINTC 0x11 n.u. PLLINTC PLLINTC PLLINTC PLLINTC PLLINTC PLLINTC PLLINTC

PLLFRACC0 0x12 PLLFRACC0 PLLFRACC0 PLLFRACC0 PLLFRACC0 PLLFRACC0 PLLFRACC0 PLLFRACC0 PLLFRACC0

PLLFRACC1 0x13 PLLFRACC1 PLLFRACC1 PLLFRACC1 PLLFRACC1 PLLFRACC1 PLLFRACC1 PLLFRACC1 PLLFRACC1

PLLFRACC2 0x14 n.u. n.u. FRACCOMPC PLLFRACC2 PLLFRACC2 PLLFRACC2 PLLFRACC2 PLLFRACC2

PLLINTD 0x15 n.u. PLLINTD PLLINTD PLLINTD PLLINTD PLLINTD PLLINTD PLLINTD

PLLFRACD0 0x16 PLLFRACD0 PLLFRACD0 PLLFRACD0 PLLFRACD0 PLLFRACD0 PLLFRACD0 PLLFRACD0 PLLFRACD0

PLLFRACD1 0x17 PLLFRACD1 PLLFRACD1 PLLFRACD1 PLLFRACD1 PLLFRACD1 PLLFRACD1 PLLFRACD1 PLLFRACD1

PLLFRACD2 0x18 n.u. n.u. FRACCOMPD PLLFRACD2 PLLFRACD2 PLLFRACD2 PLLFRACD2 PLLFRACD2

SLOPEDIV 0x19 SLOPEDIV SLOPEDIV SLOPEDIV SLOPEDIV SLOPEDIV SLOPEDIV SLOPEDIV SLOPEDIV

POWCFG0 0x1A PA_PS2 PA_PS2 PA_PS2 PA_PS1 PA_PS1 PA_PS1 SLOPEDIV SLOPEDIV

POWCFG1 0x1B POUT2 POUT2 POUT2 POUT2 POUT1 POUT1 POUT1 POUT1

FDEV 0x1C FDEVSCALE FDEVSCALE FDEVSCALE FDEV FDEV FDEV FDEV FDEV

GFDIV 0x1D GFDIV GFDIV GFDIV GFDIV GFDIV GFDIV GFDIV GFDIV

GFXOSC 0x1E FHBLANK reserved reserved reserved GFBYP GFDIV GFDIV GFDIV

ANTTDCC 0x1F DCCVBYP DCCDISABLE DCCCONF DCCCONF TUNETOP TUNETOP TUNETOP TUNETOP

RES1 0x20 n.u. reserved reserved reserved reserved reserved reserved reserved

VAC0 0x21 VAC_CTR VAC_CTR VAC_CTR VAC_CTR VAC_CTR VAC_CTR VAC_CTR VAC_CTR

VAC1 0x22 n.u. VAC_NXOSC VAC_NXOSC VAC_NXOSC VAC_NXOSC VAC_NXOSC VAC_NXOSC VAC_CTR

VACERRTH 0x23 VAC_ERRTH VAC_ERRTH VAC_ERRTH VAC_ERRTH VAC_ERRTH VAC_ERRTH VAC_ERRTH VAC_ERRTH

CPCFG 0x24 n.u. reserved reserved reserved CPTRIM CPTRIM CPTRIM CPTRIM

PLLBW 0x25 reserved PLLBWTRIM PLLBWTRIM PLLBWTRIM reserved reserved reserved reserved

RES2 0x26 reserved reserved reserved reserved reserved reserved reserved reserved

ENCCNT 0x27 ENCCNT ENCCNT ENCCNT ENCCNT ENCCNT ENCCNT ENCCNT ENCCNT
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3.4.3 Transmission in Advanced Mode
In the Transmission Tab of the Advanced Configuration mode, both Device Evaluation and System
Emulation options are available.

Figure 26 Advanced Mode - Transmission Tab and controls

Opposed to Basic Configuration Mode, the Transmission Command byte as well as the datagram must be
defined by the user. The TX File, whose template can be found under the File menu, defines the structure and the
content of the datagram. 

• In Device Evaluation mode (Continuous Transmit Mode), the Transmission Command byte must be defined 
within the GUI. The transmitted data is extracted from the TX File

• In System Emulation mode both Transmission Command byte and Datagram must be defined within the 
Datagram file. TESEUS allows the usage of up to 4 datagram files at the same time, as shown in above 
example Figure 26

For explanations regarding the Transmission Command byte, please refer to the TDA5150 Datasheet. To start
a transmission, click on the Load button, which loads a TX File. A template can be found in the File menu. If the
user does wish to clear the uploaded file, just press the button ´C´, followed by a click on the Transmit button. 

To stop the transmission, click the Stop button, located at bottom right region. 

In the same Tab up to 4 different Tx Files can be processed within individual Tx boxes (Datagram 1..4)

The datagram file can be created ad-hoc in order to meet the format required by your application. Open the file
with a text editor (Notepad for instance). The TX File contains a self explicative description regarding its structure
and organization.
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Figure 27 Tx File structure

The transmission file is composed by three main fields

• description
• settings 
• datagram

The description field contains the description you want to visualize within the datagram window in Teseus. This
feature can be used to easily visualize the description of the transmission and to distinguish it from other,
alternative files.

The settings field defines the Transmission Command byte. Please refer to the TDA5150 Datasheet for detailed
explanations.

The datagram field is composed of two commands OVERSAMPLING and CODING, followed by the datagram
payload content, which should be transmitted.

OVERSAMPLING is used to oversample the data that is passed to the TDA5150. 

By setting for example OVERSAMPLING to 5, every BIT will be transformed by the software into 5 chips. Same
behavior is true for BYTEs. 

For example, if the data rate is set to 1kbps and OVERSAMPLING is 5, the data passed to the TDA5150 will be
5 kchips per second.

That is, for every data-bit the device will receive and transmit 5 chips at a rate 5 times higher than the nominal data
rate. This option can be useful for example during a ASK transmission for instance, if the protocol requires a
moment of silence of 1.2 bits time length between two consecutive parts of the transmission, oversampling by 5
allows to transmit for the 0.2 chip long duration a space (brake).

CODING is used to encode via SW the data which is then passed to the TDA5150. 

The following parameters (non case sensitive) are implemented:

• NRZ
• Manchester
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• Differential Manchester
• Biphase Space
• Biphase Mark
• Miller

Coding is accomplished by TESEUS and the datastream transferred to the SIB board afterwards. The data to be
transmitted is specified by Data Type descriptors, as follows

• "BIT" ...... Bits, will be encoded. Data is contained in "01001" - like sequences. Spaces inserted in the string, 
for better overview and to structure the data are allowed. 

• "CHIP" ..... Chips, usable for example for Manchester Code Violation patterns. Data is contained in "01001" - 
like sequences. Spaces in the string to structure the data are allowed. 

• "BYTE" ..... Byte Data, will be converted to Bits (MSB transmitted first). Data is declared bytewise or string like, 
according to following styles
– 0x0F ...... ..Hexadecimal byte (C-style)
– &H3A ...... Hexadecimal byte (VB.net style)
– 127 ....... ...Decimal Byte
– 'B' ....... .....Single ASCII Character
– 'test' .... ....ASCII Character String

After defining the datagram, save the TX File into a work folder, load it according to previous instructions, then
click on the Transmit button.
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3.5 Firmware Mode
This GUI, similar in functionality to the Advanced Configuration, allows to access and program all the registers
(SFRs) of the TDA5150. The main difference versus the Advanced GUI is the graphical interface and a reduced
set of restrictions by setting of the parameters. It is therefore recommended to use this GUI after all the device´s
parameters and behavior are understood. 

The sequence of the commands and programming parameters follows the actual order of the registers
(hexadecimal addresses in incrementing order) rather than any other logical organization. The tabs are named in
accordance with the TDA5150 SFR address regions and commands are grouped alike.

Some optional controls, like a PLL frequency calculator, a VAC calculator and a frequency deviation calculator are
available for advanced users.

Figure 28 Firmware Mode - SFR tabs

The transmission tab reflects the same structure used in the Advanced Configuration. 
Please refer to “Transmission in Advanced Mode” on Page 30 for further details.
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Figure 29 Firmware Mode - Transmission tab
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4 TDA5150 Evaluation Board
The TDA5150 Evaluation Boards are deliverable in 5 different matching versions, each optimized in terms of
output stage efficiency (RF-PA), for the ISM bands and nominal power classes listed below.

Additionally a SIB (System Interface Board) can be ordered, this last board is applicable for all Evaluation
Boards.

If a user requires Evaluation Boards for more ISM frequency bands - for instance for 315MHz and 915MHz, on
cost saving reasons a single SIB may be ordered in conjunction with several Evaluation Boards. However this
solution (more Evaluation Boards and a single SIB) excludes the possibility of simultaneous work, with more
Evaluation Boards at the same time.

Figure 30 TDA5150 Evaluation Board (version V1.1; component side)

Table 5 Deliverable Interface and Evaluation Board versions

ISM Band [MHz] RF-Power [dBm] ISAR Order Number

315 +5 SP000356305

434 +5 SP000356301

434 +10 SP000356304

868 +10 SP000356303

915 +10 SP000356302

SIB Board V1.2  x SP000357842
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Figure 31 TDA5150 Evaluation Board schematic (version V1.1)
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Figure 32 TDA5150 Evaluation Board V1.1, top view with part designators

Figure 33 TDA5150 Evaluation Board V1.1, top copper layer
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Figure 34 Connectors and docking points on Evaluation Board V1.1

• X3 External voltage supply pins
• X7 Pins for probing the digital signals (CLKOUT, SCK, SDIO, EN)
• X6 ground connections (GND for probes)
• JP1 External or Internal Voltage Supply selector
• JP2 TDA5150 total current measurement pins
• JP3 RF Power Amplifier current measurement pins
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5 SIB Board and SPI protocol
SIB stands for Standard Interface Board. Its main function is to interface the PC with the TDA5150 Evaluation
Board. The data is downloaded from PC, steered by TESEUS to the SIB, stored in buffers and used to program
the TDA5150 via the SPI interface.

Besides the SIB can supply with regulated voltage the TDA5150 Evaluation Board. The delivered supply voltage
is Programable in steps of 0.1 V via the TESEUS tool (see also the bottom right side of General tab by Figure 24

Figure 35 SIB board version V1.2, top view

• Button A - Reset the USB interface chip
• Button B - used to reset the microcontroller within the FPGA
• Button C - not used
• Button D - not used
• LED1 - power supply (from USB) indicator. Probed after FTDI connect
• LED2 - flashes when a command is transmitted from the PC to the SIB. If the LED is steadily ON (or more than 

1 sec.), then an error occurred. Please press button B to reset the microcontroller and re-boot the system
• LED3 - no function assigned
• LED4 - no function assigned
• LED5 and LED6 - indicator for programmable power supply status. LED6 is also used during internal FW tests, 

should be OFF during normal operation

L2    L3   L4

   B L5              L6

A

USB

C     D

L1
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Figure 36 Example for data transfer over the SPI bus

In the above picture the process of data transfer between the SIB and TDA5150 is shown, exemplified on the Read
operation of a register (SFR). During first part the Operation Code (Read) is transferred, followed by SFR address
(0x01

in this example), then 8 bits of data (0x80) are read from register.

Namely the ENable line, the SDIO data line, the SCK clock line are represented, and at the screenshot’s bottom,
the SCK channel again, but assigned to an analogue channel and recorded accordingly instead of recording it as
a digital line.

In recent implementation of TESEUS whenever a new transmission is started, all the 35 writable SFR registers of
the TDA5150 are programmed, one by one (even if not all of the registers are used in a particular usecase. For
instance if only Channel A of PLL is used, still all the registers assigned to Channel B; C and D are programmed
(i.e. the PLL integer and fractional SFRs). This is of course not mandatory and the user can shorten up the
application programming procedure, limiting the transfer to those SFRs, which must be refreshed.

Note: The write commands generated by the SIB board are individual SFR register write operations (of 
Write[Address:Data] form). In other words in this implementation the SFRs are not updated in BURST Mode, 
but in individual Register Write mode, for ease of SPI communication debugging. However the user is free 
to use BURST Mode for register programming (in the user application) thus shorting at some extent the dead 
time used for programming the SFRs. A Read operation of the Status Register TXSTAT (0x01) is 
recommended before Burst Write, to make shure that any fail condition, latched previously is cleared.

The communication between SIB and the TDA5150 transmitter board is implemented in such way (in TESEUS)
that immediately after programming of a SFR register, the corresponding checksum is read back and checked for
errors (i.e SPICHKSUM register 0x00 is read after a SFR write operation), as shown by Figure 37.

Note: Even if the TDA5150 can handle SPI transfer speeds up to 2Mbps, due to limitations of the SIB board, (i.e. 
the on-board FPGA) the clock frequency output by SIB is limited to the [50..500] kHz range
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Figure 37 Example of programming a Special Function Register (SFR)

After all the 35 registers are correctly written, the transmission is started by launching the Transmission Command
Byte, followed by the datagram (which is input into the modulator).

Transmission starts when a SCK active edge is detected after transmission of TX Command Byte.

Note: This is just an example how the SPI communication between the SIB board and the TDA5150 can be 
handled. In particular application approaches significantly different from those shown can be implemented. 
For example, instead of individually programming each register, the burst mode programming can be used 
and the dead time, required to transfer the data into SFRs shortened.
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